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Photoshop 6.0 
 
Photoshop is a graphics program and is used to design, create and modify images. 
You can: 

• Retouch an image 
• Apply special effects 
• Swap details between photos 
• Introduce text and logos 
• Create images from scratch 

The Work Area 
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Options Bar 
  
 
 

The Options Bar is located at the top of Photoshop screen below the Menu Bar.  The fields in the 
Options Bar are context sensitive meaning that when a tool is selected from the toolbox the 
Options Bar will change to reflect options for the selected tool.  Some new tools have been added 
to the Options Bar that were only accessible via keyboard shortcuts.  For example, Add to a 
Selection or Remove from a Selection. 
 
Another new feature that ties into the Options Bar is the Palette Well.  The Palette Well is 
located on the right side of the Options Bar. The purpose of the Palette Well is to dock palettes 
that you use often.    This new feature keeps the palettes out of the way, but ready for you to use.   
 

All the visible tabs in the example on the left were drug over 
to the Palette Well individually.  Once the tabs are located 
in the Palette Well just click on the tab and the palette will 
display. 
 
Moving tabs to the Palette Well saves you space on your 
desktop. 
 
 
 

 
Photoshop Preferences 
Photoshop Preference settings are used to change or set general display options, file saving 
options, cursor options, transparency options and scratch disks options.  The Preference settings 
are located under the Edit Menu.  Note:  The Preference settings used to be located in the File 
Menu with earlier versions of  Photoshop. 

Creating and Opening a Canvas 
• To Open a file choose  File, Open and select the file.   
• To create a canvas choose File, New and select the dimensions for the new canvas. 

Saving a Photoshop File 
• To save a Photoshop file and preserve all layers, choose File,  Save As, name the file, 

leave the .psd file extension and navigate to the drive and folder for storage.   
• To save a file in a file format that is something other than .psd choose  File,  Save As and 

select the Format option from  the file type and choose Save. 
 
Note:  It is always a good idea to save a copy of the original image before you edit it by choosing  
File, Save As, and select the Copy from the Save Options.  See the last page of this handout for 
various file types. 
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The Toolbox 
The Toolbox contains several different tools that can be used to edit or create images.  Position 
the mouse cursor anywhere on the tool icon in the Toolbox and a yellow tool tip will appear 
displaying the name of the tool.   

• To display the toolbox choose  Window  |  Show Tools 
• To hide the toolbox  choose   Window  |  Hide Tools 
• To move the toolbox click in the Title bar of the toolbox and drag to a new location. 

 
Selecting  a Tool 

Select a tool by clicking with the mouse on the tool icon 
in the Toolbox.    A small triangle in the bottom right 
corner of the tool icon indicates additional options or 

Hidden tools that can be chosen, aka   fly-out menu.   
 
Click with the mouse on a tool from the fly-out menu to select the tool. The shortcut key for the 
tool is located on the right-hand side of the tool.  Press the Shift key + the shortcut key to switch 
between the tools. 

Status Bar 
The Status Bar sits at the bottom of the Photoshop window (when turned on).  The Status bar 
provides information on current magnification and file size.  The status bar will also display a 
brief instruction message on how to use the selected tool. 
 

• To display the Status Bar  choose Window, Show Status Bar 
• To hide the Status Bar choose Window,  Hide Status Bar 
• File size information:   The first value indicates the size if saved as a flattened file with 

no layer data; the second value indicates the size if saved with all layers and channels. 
 

•  

Screen Modes 
An image can be viewed in three different screen modes in Photoshop.  The screen mode buttons 
are located at the bottom of the Toolbox.  Click on any one of the three buttons to change the 
mode. 
 

• Standard Screen Mode  (left button) displays the default window with a menu bar at 
the top and scroll bars on the sides. 

• Full Screen Mode with Menu Bar  (center button) displays a full screen window with 
a menu bar but no title bar or scroll bars. 

 
Tip:  To change the gray background that surrounds your image choose a foreground color 
and select the Paint Bucket tool from the toolbox.  Shift-click with the mouse in the gray 
area surrounding your image and the color will change to match the foreground color. 
 

• Full Screen Mode  (right button) displays a full screen window with no title bar, menu 
bar, or scroll bars.  Press the Tab key to toggle the palettes and toolbox off and on. 

 
Tip:  Press the F-key to switch between the different screen modes. 
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Move the triangle to 
zoom in or zoom out.   

Zoom Level 

Zoom in or Zoom out 
options 

 

New View  
At times you may want to look at the same image at different magnifications while editing it.  
You can open the same image in multiple windows and whatever changes you make in one 
window will apply to all windows open for that one particular image.   
 
• Choose   View  |  New View 

 

Window Display Options for the Image 
• Position the mouse cursor in the Title bar and drag the window to a new location. 
• Choose   Window  |  Cascade    to display windows stacked and cascading from top left to 

bottom right of screen. 
• Choose  Window  | Tile  to display windows edge to edge. 
 

Closing windows 
• Click in the window you want to close 
• Choose   File  |  Close  
• To close all windows choose   Window  |  Close  All 

Navigator Palette 
The Navigator Palette is used to zoom in/out of a particular area of an image.   

• Choose   Window  |  Show Navigator to display the Navigator Palette 
• Choose   Window  |  Hide  Navigator to hide the Navigator Palette 

 
 
 
 
 

 
 
 

 
 

 
 
 

Zoom Tool 
The Zoom tool is used to magnify and/or reduce a particular area of an image while editing.  An 
image zoomed in at 100% displays how the image will appear in a browser.  The percentage of 
the zoom level will display in the title bar of the image, the status bar of Photoshop and the 
Navigator Palette. 
 
 
 
 



 

R:\Users\fparker\photoshop6\photoshop6.doc                                                                                             Page  5  of  16 

Different Ways to Use the Zoom Tool 
 

• Zoom In on an image by selecting the Zoom tool from the toolbox and clicking on the 
image.   Each click with the mouse will zoom in to the next preset zoom percentage.   

 
• Select the Zoom In tool from the View Menu and the image will zoom in to the next 

preset zoon percentage. 
 

• Access the shortcut key for Zoom In by pressing Ctrl  and the + (plus) key. 
 

• Users can switch to the Zoom tool while using any other tool in Photoshop by pressing 
and holding the  Ctrl + Spacebar and at the same time clicking on the area of the image to 
be zoomed in.  

 
• Zoom In or Zoom Out of an image by typing the zoom percentage in the Navigator 

Palette or the Status Bar. 
 

• Reset the Zoom Level to 100% by double clicking with the mouse on the Zoom Tool in 
the toolbox.   

 
• Reduce the zoom level one level at a time by selecting the Zoom Out from the View 

Menu.  
 

• Reduce the zoom level by using the shortcut keys Ctrl and the – (minus) key.   Press and 
hold the Ctrl key while pressing the – (minus) key repeatedly until you are at the 
preferred zoom level.    

 
• Reduce the zoom level by selecting the Zoom tool from the toolbox and pressing the Alt 

key while clicking with the mouse on the image. 
 

 
Navigating Around the Different Magnifications. 

• Use the Scroll Bars on the image window. 
• Navigate around the image by selecting the Hand tool from the toolbox and left-click 

with the mouse while dragging the Hand tool over the image.  
 
Tip:  Switch to the Hand tool while using a different tool by holding down the spacebar.  

 

Creating Selections 
Selecting an area of an image allows you to isolate an area of an image that you want to work 
with. A dotted selection border, also called a selection marquee, indicates a selected area on an 
image.  The area outside the selection border is protected while you move, copy, paint, or apply 
special effects to the isolated area. 
 
When using the Selection tools use the Options Bar (new to Photoshop 6.0) to add, remove and 
intersect selections of an image.  The new Options Bar also has the Feathering tool readily 
available along with the anti-alias and Style Menu.   
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Marquee Tools 
 
There are four Marquee tools to choose from:  Rectangular Tool, Elliptical Tool, Single Row 
Tool and the Single Column Tool.  The Single and Column Row tools are not used very often 
and will not be used in the class examples. 
 
Begin the selection process by selecting the Marquee tool from the toolbox.  Next, select the 
New Selection icon from the Options Bar to start a new selection.  Last, select a Style for the 
selection from the Options Bar. 
 
 After all options have been turned on for the selection then left-click and drag the selection tool 
around the area of the image to be selected.    Use the Add/Remove icons from the Option bar to 
modify the existing selection. 
 
Tip:  Remember to Feather your selection if you plan to copy and paste it into another canvas. 
 
Tip: The Feathering options do not reset when making new selections.   
 
Defining the Marquee Styles 
Remember to specify a selection Style prior to making the actual selection.  The different Styles 
are listed below: 
 
Normal:  Click and drag to make a normal selection. 
 
Constrained Aspect Ratio:  Use the Constrained Aspect Ratio to set a height-to-width ratio. 
Enter values (decimal values are valid) for the aspect ratio. For example, to draw a marquee 
twice as wide as it is high, enter 2 for the width and 1 for the height.  
 
Fixed Size:  The width and height selection are set and defined in pixels.  Just click on the image 
and an area will be selected according to the fixed size. 
 
 
Using the Marquee Tools 
 
Rectangular Marquee Tool 
Use the Rectangular Marquee tool to make a rectangular or square selection of an image.     Hold 
the Shift key down while using the Rectangular Marquee tool to draw a square over the image.    
 
Tip:  Press the Shift + M keys to switch between the Rectangular and Elliptical Marquee Tool.   
 
Tip:  Hold the Alt key down while drawing a Rectangular or Elliptical selection and the 
selection process will start in the center and move outwards. 
 
Remove the selection by choosing   Select  |  Deselect or by using the shortcut keys Ctrl+D.   
Clicking outside the selected area of the image will also deselect the selected area of the image.  
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Elliptical Marquee Tool   
The Elliptical marquee tool works similar to the Rectangular marquee tool except that it makes a 
circular selection rather than a rectangular or square selection.   Hold the Shift key down while 
making the selection and the selection will be a perfect circle. 
 

Lasso Tools   
Use the lasso tools to create freeform selections.   
 
Tip:  Press the Shift+L shortcut keys to switch between all the available Lasso tools in the Lasso 
fly-out menu.  
 
 
Lasso Tool  
Use the Lasso tool to draw freehand around a portion of the image you want to select.  Left-click 
the mouse and trace the area of the image you want to select.   
 
Polygon Lasso Tool   
The Polygon Lasso tool is similar to the Lasso tool where it lets you make a freehand selection of 
the image.  However, the Polygon Lasso tool has an added feature where you can click on 
different points in your image to set corners.  Setting corners while making selections is 
sometimes easier then trying to drag the mouse around multiple corners. 
 
 
Magnetic Lasso Tool   
Click once to set the start point of the Magnetic Lasso tool and move the mouse along the edge 
of the image that you want to select.  No need to click and drag – just move the mouse.  Double-
click the mouse on starting point to close the selection. 
 
Tip: The Feathering options do not reset when making new selections.   
 
 
Magic Wand Tool   
The Magic Wand tools selects pixels based on the brightness of the pixels.  Set a tolerance 
between 0 and 255.  A tolerance of 0 would select a small area (it is only selecting pixels with a 
brightness very close to where you clicked).  A tolerance of 255 would be the similar to a Select 
All.   
 
Tip: Press the Shift key and click with the mouse in an area of the image that you want to add to 
the first selection.   
 

More Selecting Options 
 

• Select all pixels on a layer within the canvas boundaries by choosing Select All, Ctrl+A, 
from the Select Menu. 

 
• Deselect a selected area of an image by choosing Deselect from the Select Menu. 
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Tip:  If you are using the rectangular marquee, elliptical marquee, or lasso tool, click anywhere 
outside the selected area to deselect. 
 

• Reselect the most recent selection by choosing Reselect from the Select Menu. 
 

Paint Tools 
 

Selecting Foreground and Background Colors   
The Foreground and Background color chips are located in the toolbox.  The Foreground color 
chip is used to paint, fill selections, and stroke (add a border) areas of an image.   The 
background color chip is used to make gradient colors and at times used as the background color 
when using the erase to background tool.   
 
Tip:  Some filters use foreground and background colors. 
   
 
Foreground Color  
The Foreground Color tool determines which color is used while using the paint tools.  Change 
the Foreground Color by clicking the Foreground Color icon to display the Standard Color 
Picker dialog box.  From the Standard Color Picker dialog box click on a color with the mouse 
pointer and choose OK. 
 
Background Color  
 
The Background color tools is used when erasing the background of the image or when you 
increase the size of the canvas by choosing  Image,  Canvas Size.   
 
Color Picker Dialog Box 
When viewing the Color Picker dialog Box the colors available to 
select from are located in the large square on the left side.    Use the 
Vertical Gradient that is located in the middle of the dialog box to 
select the general color you want to use.  The two color swatches located to the right of the 
Vertical Gradient display the selected color in top color swatch and the color previously chosen 
in the lower color swatch. 
 
BEWARE of  Out-of-Gamut and Non-Web-Safe Colors  
 
Out-of-Gamut 
The out-of-gamut warning, a small triangle appearing to the right of the color swatches in the 
dialog box, signal that the color chosen is not reproducible in CMYK mode, which means it 
cannot be printed without shifting to a different color.  Photoshop provides a sample of the color 
it will shift to in a square directly below the out-of-gamut warning triangle.  Click on the small 
square to select the color or with the dialog box open have Photoshop display how the colors will 
look when printed by choosing  View, Proof Colors. 
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Swap the Foreground and Background colors by clicking the small curved doubled edged 

arrow located in the top-right corner of the Foreground and Background Color Control Box.   
 
   Reset the Foreground and Background colors to their default color of black and white by 

clicking on the small icon located in the lower- left corner of the Foreground and Background 
Color Control Box. 

Using the Fill Tool 
One of several ways to use the Fill tool is to select it from the Edit 
Menu.  Start by creating a selection on the canvas.  Next, choose  
Edit, Fill and choose an option from the Contents area of the Fill 
dialog box.  Photoshop will use the color in the Foreground and 
Background color chips when selecting Foreground or Background 
color from the Fill Dialog box.     
 
Extra :  Create a pattern and use it as a fill.  Use the Rectangular 
Marquee tool to select a color or pattern you like on a canvas.  Next, choose Edit, Define as 
Pattern and assign a name for the pattern.  The Pattern you make will now be available to use 
from the Fill dialog box.   
 
 

Paint Bucket   
 
Tip:  Photoshop 6 grouped the Paint Bucket with the Gradient Tool.   
 
The Paint Bucket tool is used to fill selected areas or an entire canvas with a fill color. 
 

• Select the Paint Bucket tool from the toolbox. 
• Click in the area where you want to use the fill color. 
• Whatever color is displayed in the Foreground color box will be used to fill the selected 

area.  
• To change the Fill Color click with the mouse on the Foreground Color icon in the 

toolbox and select a different colo r from the color picker dialog box.  Choose OK when 
finished.  To apply the Fill Color select the Paint Bucket from the toolbox and the 
Foreground Color will be applied to the selected area. 

 

Painting With Gradients   
Give your image a different look by applying a gradient style.  Gradients can be applied to 
selections or to an entire layer.  Select the Gradient tool from the toolbox and then select the 
gradient style from the Options Bar.   

.   
 

1.  
 
• Select a color scheme for the gradient.  There are two ways to select gradient colors: 

1. From the Option Bar select a preset color combination under the Gradient Picker. 
2. From the toolbox select a Foreground and Background color from the color picker.  
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• After the gradient style and gradient colors have been selected, position the cursor inside the 
image and left-click and drag across the image or canvas.  

Using Brushes 
The brushes in Photoshop aren’t only used for painting.  The brushes can be used for drawing 
and selecting as well.  The Airbrush, paintbrush, pencil, line tool and eraser can all be used for 
drawing. 
 
Available options for brushes include changes in the opacity, pressure, blend mode and some 
have fade and wet edges as available options.  
 
Photoshop has preset brush sizes to select from while painting or drawing.   Select the tool from 
the toolbox and choose a brush size and type from the Options Bar. 
 
The Brushes Palette is now located in the Options Bar.   

 
Click on the Pull-down arrow for the brushes to 

display the brush options.   
 
Click with the mouse on the black arrow pointing right 

and select Load Brushes to load additional brushes 
that come with Photoshop. 

 
 
 
 

 
Tip:  The Define Brush tool is now located under the Edit Menu.  Use the Rectangular 
Marquee tool to make a selection and then choose Edit, Define  Brush.    
 
 
Airbrush Tool    
The Airbrush is used to paint soft strokes on your image.  Available options include Blend mode, 
Pressure, and Fade steps. 

 
 
 

• Select the Airbrush Tool from the toolbox 
• Select the Foreground Color tool to open the color picker and select a color for the airbrush. 
• From the Options Bar select the Pressure and Fade steps 
• Select a brush from Options Bar 
• Click and drag the cursor on the image to draw 
 
 
Paintbrush Tool    
The Paintbrush tool works similar to the Airbrush tool.  A couple of different settings for the 
Paintbrush tool are the Opacity settings and the Wet Edges setting.  Opacity settings at 100 
percent display the color as a solid.  As the Opacity setting is set at a lower percentage the color 
fades and become translucent.  The Wet Edges setting applies more paint towards the edges of 
the drawing, leaving the center of the drawing more transparent.  



 

R:\Users\fparker\photoshop6\photoshop6.doc                                                                                             Page  11  of  16 

 
 
 

• Select the paintbrush Tool from the toolbox 
• Select the Foreground Color tool to open the color picker and select a color for the 

Paintbrush. 
• From the Options Bar select a setting for Opacity.  
• Select the Wet Edges setting if necessary. 
• Select a brush from the Options Bar. 
• Click and drag the cursor on the image to paint. 

 
 

Pencil Tool   
Pencil paints a hard-edged line of any thickness.  When using the Pencil tool only brushes with a 
hard edge can be selected from the brush options in the Options Bar.  Available settings for the 
Pencil Tool include the Opacity and the Auto Erase feature.  When the Auto Erase feature is 
selected draw over an existing line and the line will be erased.  
 
The new short cut key for the pencil is “b”.   Select the “b” key at any time while working in 
PhotoShop and the toolbox will switch to the Pencil tool. 
 
Tip:  Press the Shift key while using the Pencil tool to connect lines. 
 
 
Using the Pencil Tool 
Tip:  The Pencil tool is located behind the Paintbrush tool in the toolbox. 
 

 
 

 
• Select the Pencil Tool from the toolbox 
• Select the Foreground Color tool to open the color picker and select a color for the Pencil 
• From the Pencil Options Palette select a setting for the Opacity 
• Select a brush from the Brush Palette 
• Click and drag the cursor on the image to paint 

 
Another way to use the Pencil Tool 

• Select the Pencil Tool from the toolbox  
• Select the Foreground Color tool to open the color picker and select a color for the Pencil 
• From the Pencil Options Palette select a setting for the Opacity 
• Select a brush from the Brush Palette 
• Click once where you want the line to start 
• Shift click where you want the line to end 
• PhotoShop will insert a straight line between the two points. 

Tip:  Continue to Shift click if you want to attach more than one line  
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Line Tool   
Use the Line Tool to draw a line.  Note:  The Line tool is located in a flyout menu under the 
Vector tools. 
 

 
 

• Select the Line Tool from the toolbox 
• Select the Foreground Color tool to open the color picker and select a color for the Line 
• From the Line Options Palette select a setting for the Opacity and Weight (thickness of 

the line) 
• Select a brush from the Brush Palette 
• Click and drag the cursor on the image to paint 

 
Drawing lines with Arrows  

• Select the Line Tool from the toolbox 
• Select the Foreground Color tool to open the color picker and 

select a color for the Line 
• From the Options Bar select the Geometry Options menu and 

select Arrowheads.  From the Arrowheads dialog box insert the  
Opacity, Weight (thickness of the line) and for arrows select 
whether you want an arrow at the start or end of a line or  select 
both options if you want an arrow at the start and end of the line. 

• Click and drag the cursor on the image to paint 
 

Creating a New Brush 
Select a brush tool from the toolbox.  From the Options Bar open 
the Brushes Palette.   

 
Select the Brush Options and choose New 
Brush   
 
 
 
 

 
 

 
Diameter:  Determines the width of the brush shape.  
Value can range from 1 to 999 pixels.   
 
Hardness:  Determines the brush edge softness.  Zero is the 
softest. 
 
Spacing:  When spacing exceeds 30% gaps or ridges begin 
to appear in the line that is being painted.  The gaps or 
ridges will be as large as the pixel size of the brush. 
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The Stamp Tools   
• Rubber Stamp Tool 
• Pattern Stamp Tool 

 
 
Rubber Stamp Tool   
The rubber Stamp tool is great for removing imperfections such as dust and scratches, repairing 
defects and eliminating elements within the image.  This tool can be used to  copy one portion of 
an image over another 
 
 
Aligned Option 
This option keeps the cursor and the crosshairs relative to each other.  When the Aligned option 
is left unchecked the Rubber Stamp repeats the cloning from the original location.  
 
• Select the Rubber Stamp tool from the toolbox 
• Select the area of the image you want to clone.   Press the Alt key while you click on the area 

you want to clone.   
• Select the Rubber Stamp tool from the toolbox 
• Click and drag the mouse over the area of the image you want to replace. 
 

Transform Objects 
Use the Transform menu to scale, rotate, flip and distort part of an image.  Select the area of the 
image that you want to transform and choose Edit, Transform.  Double click on the image when 
finished transforming to close the transform box. 
 
 
Pattern Stamp Tool   
The Pattern Stamp tool is used to copy a pattern and apply it to a different image.   
 

• Open the image with the pattern you want to copy 
• Choose  Select  |  All 
• Choose  Edit  |  Define  Pattern 

 
Selection tools are grayed out – they don’t work for this. The Select Menu must be used. 
 

• Open a new file:    File  |  New 
• Select the Pattern Stamp Tool 
• Select a brush size from the Brush Palette 
• Click and drag in the image.  As you click and drag the mouse you will be painting the 

pattern.   
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Using the Type Tool 
 
When the Type Tool is selected the Type Tool options are located in the Options Bar.  An even 
better improvement with the Type Tool is the “good-bye” to the Type Tool dialog box.  Text can 
be typed directly on the canvas now by selecting the Type Tool and typing the text.   
 
New Feature!!! Warped Text   
 
Creating Text   
• Select the Type tool from the toolbox. 
• Select a Type Tool Style. 
• Click anywhere in the image to activate the Type tool and type your text.   
• All options for the Type tool are located in the Options Bar. 
• Select the Arrow when finished to deactivate the type tool.  
 
 

Applying Layer Effects  to Type 
Use any or all of the five built in layer effects.  These 
layer effects aren’t designed specifically for Text, but 
they work great.    
 
From the Menu choose    Layers  |   Layer Styles 
 
Press the PREV and NEXT button to page through 
the available options.    
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Saving Files 
 
Photoshop is capable of saving files to many different formats.   Choose the Save option from the 
File menu and Photoshop will save the file as a PSD file.   To save your file in a format other 
than PSD use the Save As option from the File menu and select the file type from the Save As 
pull down menu.    
 
If the image you create in Photoshop includes layers and channels the only choice available to 
save the image is the PSD format.   If you want to save the file in a non-PSD format then the 
layers must be flattened.     
 

Flatten an Image 
 
Be sure the Layer’s tab is active.  Click on the 
black arrow to the right of the Layers tab.  
Select Flatten Image from the Layers menu. 
  
 
 
 
  
 
Note: another option would be to select the Save As Copy feature from the File menu.  
Photoshop will automatically flatten all layers when using the Save As Copy feature and saving 
the document in a format other than PSD.     
 

Inserting Your Image Into Another Application 
Once your image has been saved in a file other than PSD it can be inserted as a picture in your 
favorite application.   
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Common File Types 

PSD 
Photoshop  

A Photoshop file which preserves all layers, masks, channels, and selection 
you created. 
 

BMP 
Bitmap 

File format native to Windows.  An Uncompressed file format that stores the 
pixels and their color information.   
 
Bitmapped graphics are typical of paint programs, which treat images as 
collections of dots rather than as shapes. 

PCX 
PC Format 

A graphical file format that compresses its image data with RLE-type 
compression, used by early versions of Windows Paintbrush. 

PCX files are compressed, and are smaller than BMP 

EPS 
Encapsulated 
PostScript 

A PostScript file format that can be used as an independent entity. The EPS 
image must be incorporated into the PostScript output of an application such 
as a desktop publisher. Many high-quality clip-art packages consist of such 
images.  

A good choice for transferring files between CorelDRAW and Photoshop.  
Photoshop can’t read  CDR files, but it can read EPS files.  You can export a 
CDR file in EPS and then open the file in Photoshop.  

 

TIFF 
Tagged Image 
File Format 

A good cross-platform format that uses LZW compression.   
A standard file format commonly used for scanning, storage, and interchange 
of gray-scale graphic images. TIFF may be the only format available for 
older programs (such as older versions of MacPaint), but most modern 
programs are able to save images in a variety of other formats, such as GIF 
or JPEG. 

JPEG 
Joint 
Photographic 
Experts Group 

JPEG’s are a good choice for photographs and images with smooth gradient 
or blends.  JPEG trades off compression against loss; it can achieve a 
compression ratio of 100:1 with significant loss and possibly 20:1 with little 
noticeable loss. 

GIF 
Graphical 
Interchange 
Format 

A graphics file format developed by CompuServe and used for transmitting 
raster images on the Internet. An image may contain up to 256 colors, 
including a transparent color. The size of the file depends on the number of 
colors actually used. The LZW compression method is used to reduce the file 
size still further. 

 
 


